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Kapitola 1

Úvod

Dokumentace v £eském jazyce zatím není k dispozici, m·ºete si v²ak otev°ít dokumentaci
v anglickém jazyce [1].

REXYGEN Studio je gra�cký nástroj ur£ený pro tvorbu algoritm· pro °ízení v reál-
ném £ase s podporou rozsáhlé knihovny funk£ních blok· systému REXYGEN [2]. Vývojá°
m·ºe vyuºít mnoho funk£ních blok· od jednoduchých komparátor· a £asova£· po pokro-
£ilé a specializované bloky ur£ené pro zpracování a regulaci analogových signál·. Mezi
specializované regulátory pat°í nap°íklad PID regulátory s automatickým lad¥ním pa-
rametr·. Jakýkoli algoritmus vytvo°ený v REXYGEN Studio lze okamºit¥ zkompilovat a
stáhnout do libovolného cílového za°ízení (Linux IPC, WAGO PFC 100/200, Raspberry
Pi, TinkerBoard, RockPi, Pigeon PLC, UniPi Neuron/Axon/Patron, Insys MRX atd.).
Po úsp¥²ném zkompilování a staºení algoritmu do cílového za°ízení je moºné p°epnout
REXYGEN Studio do reºimu Watch, ve kterém lze sledovat nebo upravovat parametry
a prom¥nné funk£ních blok·. P°ipojení lze navázat lokáln¥ nebo p°es internet pomocí
standardního protokolu IPv4 nebo IPv6. Je podporováno zabezpe£ené p°ipojení pomocí
protokolu SSL.

Podrobnou dokumentaci ke knihovn¥ funk£ních blok· lze kdykoli otev°ít klávesou F1.
Dokumentace je automaticky nainstalována ve výchozím nastavení instalace a doporu-
£ujeme ji neod²krtávat.

1.1 První spu²t¥ní

Kdyº spustíte REXYGEN Studio poprvé, objeví se dialogové okno (obrázek 1.1), kde
máte n¥kolik moºností, jak za£ít svou práci. Pokud zvolíte moºnost Start with the Plain
Project, budete vyzváni k vybrání sloºky, kam se projekt uloºí, a vytvo°í se projekt s mi-
nimální kon�gurací, který lze nahrát do va²eho cílového za°ízení. Instalace REXYGENu
obsahuje rozsáhlou knihovnu p°íklad·. Doporu£ujeme za£ít projekt výb¥rem p°íkladu,
který pak upravíte. K tomu slouºí moºnost Start from the Example Project. Pokud máte
k dispozici jiº p°ipravený projekt, m·ºete ho otev°ít pomocí moºnosti Open an Existing
Project. Poslední moºnost - Load Project from the Target Device vám umoºní zp¥tn¥
na£íst aktuáln¥ uloºený projekt z cílového za°ízení. Pozor: Zdrojové soubory projektu
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musí být na za°ízením uloºeny!

Obrázek 1.1: Startovní menu

1.2 Reºimy aplikace

Aplikace poskytuje dva reºimy: reºim Development a reºim Watch. V reºimu Develop-
ment se algoritmus vyvíjí kreslením diagramu funk£ních blok· na plátno a nastavováním
parametr· funk£ních blok·. Aplikace m·ºe být nebo nemusí být p°ipojena k cílovému
za°ízení.

Pokud je aplikace p°ipojena k cílovému za°ízení, m·ºe být p°epnuta do reºimuWatch.
V reºimuWatch nelze vyvinutou aplikaci upravovat. Místo toho diagram funk£ních blok·
slouºí jako diagnostické rozhraní pro b¥ºící algoritmus. Uºivatelé mohou sledovat v²echny
signály, parametry, trendy a podrobnou diagnostiku cílového za°ízení.
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Kapitola 2

Kompilace, nahrávání a diagnostika
projektu

Aby byl °ídicí algoritmus uveden do provozu, musí být projekt zkompilován a výsledná
binární kon�gurace musí být nahrána do cílového za°ízení. Ob¥ akce se provád¥jí p°ímo
z vývojového nástroje REXYGEN Studio.

2.1 Kompilace projektu

Po navrºení algoritmu1 je nutné ov¥°it jeho strukturu, kon�gurace za°ízení a spojení
blok· pomocí kompilace. Kompilace vytvo°í binární soubor nazvaný binarní kon�gurace,
který lze nahrát do cílového za°ízení. Binarní kon�gurace je na platform¥/za°ízení nezá-
vislý formát souboru s p°íponou .rex. Formát binární kon�gurace je optimalizovaný pro
rychlé zpracování na cílovém za°ízení a má n¥kolik mechanism· kontroly konzistence.

B¥hem kompilace mohou nastat varování a chyby. V²echna varování, chyby a dal²í
r·zné informa£ní zprávy jsou vypsány do kompila£ního protokolu. Varování nezp·so-
bují ukon£ení kompila£ního procesu. M¥ly by ale být pe£liv¥ sledovány, protoºe pravd¥-
podobn¥ ukazují na problém, který by mohl vést k neo£ekávanému chování algoritmu.
V²echny chyby jsou povaºovány za váºné problémy a zp·sobují ukon£ení kompila£ního
procesu aniº by se vytvo°ila binární kon�gurace. V²echny chyby a varování jsou ozna£eny
svými p°íslu²nými £ísly a textovou informa£ní zprávou.

Kompilaci spustíte z menu Compiler. Projekt se zkompiluje vybráním moºnosti Com-
piler/Compile z menu, kliknutím na ikonu na panelu nástroj· nebo pouºitím klávesové
zkratky F5.

2.2 Nahrání projektu

Kon�gurace se nahraje do cílového za°ízení vybráním moºnosti Compiler/Compile and
Download z menu, kliknutím na ikonu na panelu nástroj· nebo pouºitím klávesové

1Pokyny k návrhu algoritmu najdete v p°íru£ce Getting Started pro va²e cílové za°ízeni.
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zkratky F6.
P°ed staºením do cílového za°ízení se vºdy provede kompilace projektu do binární

kon�gurace, aby se zajistila konzistence. Pokud b¥hem kompilace dojde k chyb¥, zobrazí
se kompila£ní okno a operace nahrání není k dispozici. Uºivatel musí opravit v²echny
chyby ozna£ené kompilátorem p°ed pokra£ováním v nahrávání.

Moºnost nahrávání Store con�guration permanently je nutná k uloºení kon�gurace
projektu na cílovém za°ízení tak, aby se automaticky na£etla p°i spou²t¥ní cílového za-
°ízení (nap°. po restartu, vypnutí a zapnutí napájení, výpadku proudu atd.).

Obrázek 2.1: Dialog pro kompilaci a nahrávání projektu

2.3 Aktivace licence

P°ed staºením a aktivací binární kon�gurace musí být cílové za°ízení °ádn¥ zalicenco-
vané. Pro trvalý provoz cílového za°ízení je nutné získat plnohodnotnou licenci pro dané
za°ízení z www.rexygen.com/pricing. Pro experimenty a vývoj je k dispozici DEMO
licence. DEMO licenci lze získat p°ímo z aplikace REXYGEN Studio p°i p°ipojení k ne-
zalicencovanemu cílovému za°ízení. Uºivatel m·ºe také získat DEMO licenci z webové
stránky REXYGEN.

P°i p°ipojení k nezalicencovanému cílovému za°ízení se zobrazí informa£ní dialog o
licencování (Obrázek 2.2). Uºivatel má následující t°i moºnosti:

Request a free DEMO LICENCE: Vyberte tuto moºnost, pokud chcete získat DEMO
licenci p°ímo vypln¥ním jména a e-mailové adresy, na kterou bude zaslán licen£ní klí£
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Obrázek 2.2: Dialog bez licence

(Obrázek 2.3).

Obrázek 2.3: Dialog DEMO licence

I have a LICENCE VOUCHER: Vyberte tuto moºnost, pokud jiº máte platný li-
cen£ní voucher a chcete ho pouºít na cílovém za°ízení.

I have a LICENCE KEY: Vyberte tuto moºnost, pokud jiº máte platný licen£ní klí£
a chcete ho pouºít na cílovém za°ízení.

Connect anyways: Vyberte tuto moºnost, pokud chcete pokra£ovat bez licencování
cíle. Bu¤te si v²ak v¥domi toho, ºe v¥t²ina funkcí není k dispozici bez aktivní licence.

2.4 Reºim sledování a diagnostika

Rozsáhlý diagnostický nástroj je p°ímo integrován do REXYGEN Studio. P°ed pouºitím
diagnostického nástroje musí být binární kon�gurace úsp¥²n¥ staºena do cílového za-
°ízení. Informace o nahrání binární kon�gurace do cílového za°ízení naleznete v sekci
2.2.

Diagnostický nástroj v REXYGEN Studio lze pouºít pouze tehdy, kdyº je jiº navá-
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záno aktivní p°ipojení s cílovým za°ízením. P°ipojení se uskute£ní kliknutím na Tar-
get/Connect v nabídce, kliknutím na ikonu na panelu nástroj· nebo pomocí zkratky F7.
P°ipojení m·ºe být navázáno také po nahrání binární kon�gurace do cílového za°ízení
a zobrazení dialogu, ve kterém je uºivatel dotázán, zda má být zachováno p°ipojení s
cílovým za°ízením a zda má být aktivován takzvaný Watch mode (reºim sledování).

Reºim Watch je indikován ²edým pozadím v²ech oken s funk£ními blokovými dia-
gramy. V reºimu Watch není moºné p°idávat, mazat nebo p°esouvat funk£ní bloky ani
spoje mezi bloky. Uºivatel m·ºe místo toho prohlíºet a upravovat signály vstup·, výstup·
a parametr· blok· a sledovat hodnoty signál· v reálném £ase s obnovovací periodou, kte-
rou lze upravit v dialogu Settings/Diagnostics Options a která je výchozím nastavením
jedna sekunda.

2.4.1 Sledování signál·

Bylo by neefektivní a výpo£etn¥ náro£né, kdyby v²echny signály byly sledovány okamºit¥
po aktivaci reºimu Watch. Z tohoto d·vodu jsou automaticky sledovány pouze bloky
DISPLAY. Ostatní funk£ní bloky musí uºivatel p°epnout do takzvaného Monitoring State,
pokud je chce sledovat.

Kdyº je blok v Monitoring State, jsou v²echny vstupní a výstupní hodnoty zobrazo-
vány na p°íslu²ném pinu sledovaného bloku. Blok je p°idán doMonitoring State výb¥rem
Target/Watch Selection z nabídky nebo pouºitím zkratky Ctrl+W. Blok je odebrán ze
stavu Monitoring State výb¥rem Target/Exclude from Watch Selection z nabídky nebo
pouºitím zkratky Ctrl+Shift+W. Je zde také moºnost Target/Exclude all from Watch
Selection v menu pro zastavení sledování v²ech signál· v b¥ºícím projektu.

Hodnoty parametr· jsou zobrazeny v plovoucím ºlutém okn¥, kdyº uºivatel umístí
kurzor my²i nad funk£ním blokem. Parametry lze také prohlíºet a upravovat z online
dialogu vlastností bloku, který se spustí dvojitým klepnutím nebo stisknutím Ctrl+E.
Bu¤te opatrní p°i úprav¥ hodnot parametr·, protoºe zm¥ny jsou ihned zapsány na cílové
za°ízení, kdyº je vybrán tla£ítko OK nebo Apply.

P°ed ukon£ením reºimu Watch se zobrazí dialog, který umoº¬uje p°enést v²echny
zm¥ny parametr· provedené v reºimu Watch zp¥t do výkresu. Uºivatel m·ºe p°ijmout
nebo odmítnout zm¥ny v²ech parametr· individuáln¥. To zjednodu²uje úsilí udrºovat
projekt synchronizovaný s b¥ºící kon�gurací.

Uºivatel by m¥l vºdy sledovat pravou £ást stavového °ádku, kde je indikován stav
spojení s cílovým za°ízením. Zelená barva znamená, ºe spojení je aktivní a data jsou
pravideln¥ komunikována bez chyb. �ervená barva znamená, ºe spojení s cílovým za°í-
zením bylo ne£ekan¥ uzav°eno nebo do²lo k chyb¥ b¥hem vým¥ny dat.

2.4.2 Sledování trend·

V REXYGEN jsou k dispozici bloky TRND a TRNDV, které umoº¬ují monitorovat signály
po ur£itou dobu. Blok TRND umoº¬uje ukládat aº 4 signály a blok TRNDV aº 64 signál· do
pam¥ti cílového za°ízení. Vzorky jsou ukládány synchronn¥ b¥hem provád¥ní úloh, coº
umoº¬uje ukládat a sledovat velmi rychlé procesy bez ztráty jediného vzorku.
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Obrázek 2.4: Sledování a diagnostika v reºimu Watch

Diagnostický nástroj REXYGEN Studio umoº¬uje zobrazit v²echna data uloºená v
pam¥ti bloku TRND v reºimu Watch. Pro zobrazení okna se v²emi datovými signály zob-
razenými v gra�ckém trendu sta£í dvakrát klepnout na blok TRND, kdyº je REXYGEN

Studio v reºimu Watch. Data lze p°iblíºit, zm¥nit m¥°ítko a rozsah obou os a také je lze
z okna exportovat do souboru CSV.

2.4.3 Zobrazení systémového logu REXYGEN

Na kaºdém cílovém za°ízení je k dispozici systémový log s chybovými, varovnými a
jinými informa£ními zprávami s £asovými razítky. Uºivatel m·ºe zobrazit obsah systé-
mového logu p°ímo z REXYGEN Studio vybráním Target/Show System Log z nabídky
nebo klepnutím na ikonu na panelu nástroj·. Uºivatel m·ºe procházet v²echny zprávy,
�ltrovat obsah nebo exportovat vybrané/v²echny poloºky do souboru CSV.

Typy a závaºnosti zpráv, které jsou zapsány do systémového logu REXYGEN, lze
kon�gurovat výb¥rem Target/Con�gure System Log z nabídky. Pokud je pot°eba trvale
uloºit kon�guraci systémového logu na cílovém za°ízení, musí být vybrána moºnost Safe
print �ags to the target. Pokud tato moºnost z·stane nevybrána, na£te se p°i dal²ím
spu²t¥ní systému poslední uloºená kon�gurace.
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2.4.4 Diagnostika

Podrobný nástroj pro diagnostiku lze spustit kliknutím na Target/Diagnostics v menu
nebo kliknutím na ikonu na li²t¥ nástroj·. Okno diagnostického nástroje se automaticky
zav°e p°i odpojení REXYGEN Studio od cílového za°ízení.
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Kapitola 3

Vytvo°ení knihovny
znovupouºitelných komponent

V REXYGEN je vytvá°ení znovupouºitelných komponent zaloºeno na pouºití takzvaných
subsystém·. Subsystém je kontejner pro skupinu funk£ních blok· a jejich spojení, které se
poté jeví jako jeden blok. Vno°ení subsystém· je povoleno, tj. subsystém m·ºe zahrnovat
dal²í subsystémy. Jakýkoli subsystém lze p°evést na znovupouºitelnou komponentu.

Znovupouºitelná komponenta se vytvá°í ve 3 krocích:

1. Vytvo°ení subsystému

2. Deklarace parametr· subsystému

3. P°esunutí subsystému do knihovny

Obrázek 3.1: Subsystém � kontejner pro skupinu funk£ních blok·
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3.1 Vytvo°ení subsystému

Existují dv¥ moºnosti, jak vytvo°it subsystém v REXYGEN Studio:

• Zkopírujte blok SubSystem z knihovny INOUT do daného výkresu (.mdl souboru).
Otev°ete subsystém dvojklikem. Duplikujte bloky Inport a Outport podle pot°eby.
Vloºte funk£ní bloky podle pot°eby. Napojte signály z Inport· p°es funk£ní bloky
na Outporty. P°ejmenujte Inporty a Outporty podle pot°eby.

• Vyberte skupinu blok· a pouºijte p°íkaz Create subsystem (v menu Edit→Create
subsystem). Vybrané bloky jsou poté nahrazeny blokem subsystému, který obsahuje
v²echny p·vodní bloky a bloky Inport a Outport pro signály, které p°ekra£ují
hranice pod systémem.

Výsledný subsystém obsahuje funk£ní bloky a jejich propojení, jak je ukázáno na
Obrázku 3.1.

3.2 Deklarace parametr· subsystému

Typickým poºadavkem na subsystém je mít parametry stejn¥ jako standardní funk£ní
blok, aby bylo moºné parametrizovat jeho funk£nost.

K tomuto ú£elu lze de�novat takzvané parametry subsystému. Hodnoty parametr· lze
pouºít uvnit° subsystému. Kaºdý parametr má také popis svého významu. Pro deklaraci
parametr· subsystému vyberte jeden blok subsystému a jd¥te do menu Edit→Declaration
of Parameters. Zobrazí se dialogové okno (viz Obrázek 3.2), kde m·ºete deklarovat pa-
rametry a odpovídající popisy.

Obrázek 3.2: Subsystém � Deklarace parametr·
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Jakmile jsou parametry deklarovány, subsystém funguje stejn¥ jako jakýkoli jiný blok
� dvakrát na n¥j klepn¥te a otev°ete dialogové okno Block properties. M·ºete vid¥t, ºe
dialogové okno obsahuje deklarované parametry (Obrázek 3.3).

Obrázek 3.3: Subsystém � Uºivatelem de�nované parametry

Nyní musíte upravit vnit°ek subsystému s parametry. Vyberte ho a p°ejd¥te do na-
bídky Edit→Open Subsystem.

Funk£ní bloky uvnit° subsystému musí být nakon�gurovány tak, aby p°ijímaly hod-
noty deklarovaných parametr·. Pro to otev°ete dialog Block properties jednotlivých
funk£ních blok·, za²krtn¥te polí£ko Inherit a vyberte odpovídající parametr (viz Ob-
rázek 3.4).

Obrázek 3.4: Dialog vlastností bloku � P°ijetí subsystémového parametru

Vnit°nosti hotového subsystému s parametry jsou ukázány na obrázku 3.5.
Nakonec m·ºete subsystém pouºít stejn¥ jako jakýkoli jiný blok a kon�gurovat jeho
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Obrázek 3.5: Subsystém s parametry � Vnit°ní struktura hotového subsystému

chování pomocí dialogu Block properties. Pokud v²echno funguje správn¥, nemusíte do
subsystému uº nikdy vstoupit. Pokud v²ak pot°ebujete ladit blok nebo p°idávat nové
funkce/vstupy/výstupy, m·ºete vºdy otev°ít subsystém a ud¥lat pot°ebné úpravy.

Pro demonstraci pouºití subsystém· se prosím podívejte na p°íkladový projekt 0101-
02. P°íkladové projekty jsou standardní sou£ástí REXYGEN Studio.

3.3 P°esunutí subsystému do knihovny

Jakmile máte sv·j subsystém funk£ní, s nebo bez parametr·, pravd¥podobn¥ ho budete
chtít pouºít v r·zných úlohách nebo projektech. Pro tento ú£el vytvo°te svou knihovnu
subsystém· - Va²i vlastní knihovnu znovupouºitelných komponenty.

Chcete-li to provést, vytvo°te v REXYGEN Studio nový soubor a jd¥te do nabídky
File→Document properties a zm¥¬te typ souboru na Library.

Nyní m·ºete do knihovny vloºit libovolný po£et subsystém·. Sta£í je p°etáhnout do
knihovny.

Poté uloºte knihovnu do sloºky projektu. Doporu£uje se do názvu souboru zahrnout
slovo 'library', aby byl pozd¥ji snadno rozpoznatelný. P°ípona je .mdl, stejn¥ jako u
ostatních soubor· REXYGEN Studio.

Jakmile knihovnu zav°ete a znovu otev°ete, v²imnete si, ºe její pozadí je sv¥tle modré
a knihovna je v reºimu pouze pro £tení. Pokud chcete v knihovn¥ provést n¥jaké zm¥ny,
jd¥te do nabídky File→Unlock Library. Tím se knihovna stane editovatelnou a m·ºete
provést pot°ebné úpravy. Pamatujte si, ºe zm¥ny, které provedete, se projeví ve v²ech
souborech a projektech, které pouºívají knihovnu (o tom se budeme bavit v Kapitole 4).

Poznámka 1: Subsystémy v knihovn¥ mohou být samostatné nebo mohou být postaveny
na jiných subsystémech z téºe nebo jiných uºivatelských knihoven.

Poznámka 2: V²echny soubory a projekty odkazující na komponenty v knihovn¥ odka-
zují na název souboru knihovny. Pokud p°ejmenujete existující knihovnu, dojde k poru-
²ení odkaz· na v²ech místech. VELMI SE DOPORU�UJE NEP�EMENOVÁVAT KNI-
HOVNU, jakmile jste za£ali pouºívat její obsah ve va²ich projektech.
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Kapitola 4

Pouºití uºivatelských knihoven
komponent

4.1 Zahrnutí knihovny do va²eho projektu

Kdyº máte va²i knihovnu p°ipravenou (nebo kdyº chcete pouºít knihovnu t°etí strany s
funk£ními bloky), musíte ji zahrnout do va²eho projektu. K tomu existují t°i zp·soby:

1. Umíst¥te knihovnu (soubor .mdl) do sloºky projektu.

2. P°idejte blok PROJECT do hlavního souboru projektu a nakon�gurujte jeho LibraryPath,
aby ukazovala na sloºku s knihovnou. Cesta m·ºe být absolutní nebo relativní k
sloºce projektu.

3. De�nujte globální cestu ke knihovnám v Preferences → Advanced. Cesta musí být
absolutní.

4.2 Pouºívání funk£ních blok· z knihovny

Chcete-li v projektu pouºít funk£ní blok z knihovny, otev°ete knihovnu stejn¥ jako ja-
kýkoli jiný soubor v REXYGEN Studio a p°etáhn¥te bloky funkcí do va²eho projektu.
Tím vytvo°íte tzv. reference na bloky knihovny, které m·ºete pouºít stejn¥ jako v²echny
nativní bloky REXYGEN.

Reference na knihovnu se od standardního subsystému li²í stylem horní hrany.
Rozdíl od standardního subsystému (a nejv¥t²í výhoda a hlavní ú£el odkazu na kni-

hovnu) spo£ívá v tom, ºe obsah subsystému je dán knihovnou. Pokud tedy aktualizujete
knihovnu vy nebo kdokoliv jiný, zm¥ny budou rozdistribuovány do v²ech subsystém·,
které odkazují na knihovnu. Pro aplikování zm¥n v projektu budete pot°ebovat otev°ít
projekt v REXYGEN Studio.

Prosím, koukn¥te na ukázkový projekt 0101-03, který ukazuje pouºití uºivatelem
de�novaných knihoven. Ukázkové projekty jsou standardní sou£ástí REXYGEN Studio.
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Obrázek 4.1: Standardní subsystém vs. Reference knihovny

Poznámka: V²echny soubory a projekty odkazující na komponenty v knihovn¥ se od-
kazují na název souboru knihovny. Pokud p°ejmenujete existující knihovnu, dojde k p°e-
ru²ení odkaz· na v²ech místech. D�RAZN� SE NEDOPORU�UJE P�EMENOVÁVAT
KNIHOVNU, jakmile jste za£ali pouºívat její obsah ve svých projektech.

4.3 Odpojení odkazu na knihovnu

V n¥kterých p°ípadech m·ºe být nutné p°eru²it spojení mezi odkazem na knihovnu a
jeho p·vodem. VAROVÁNÍ! Tento proces je NEVRATNÝ. Tímto se knihovní subsys-
tém zm¥ní na standardní subsystém. Pro provedení vyberte blok a jd¥te do nabídky
Edit→Break Library Link. Ihned si v²imnete, ºe horní okraj bloku je nyní silná plná
£ára, coº nazna£uje, ºe subsystém jiº není závislý na knihovn¥.
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Kapitola 5

Perzistentní pam¥´

REXYGEN podporuje trvalé ukládání parametr· blok· funkcí. Interní stavy vybraných
blok· funkcí mohou být také trvale uloºeny. Fungování perzistentní pam¥ti je speci-
�cké pro cílovou platformu. Pokud cílová platforma nemá ºádnou podporovanou trva-
lou pam¥´, perzistentní parametry budou p°i výchozím nastavení ukládány do souboru
permem.dat (do stejného adresá°e, kde je uloºen exec.rex - /rex/rexcore na cílových
platformách Linux nebo C:\ProgramData\REXControls\REX_<verze>\RexCore na cílo-
vých platformách Windows).

Pro uloºení parametr· funk£ních blok· musí být za²krtnuta vlastnost Persistent

parameters. V²echny parametry funk£ních blok· a také interní stavy vybraných blok·
budou uloºeny (s výjimkou polí).

Následuje seznam blok· funkcí s perzistentními interními stavy:

• INTE

• SINT

• COUNT

• SHIFTOCT

• OSD

• SHLD

• DIF_

• TIMER_

• ABSROT

• E/ATMT

Výchozí £as ukládání je 300 sekund, výchozí velikost trvalé pam¥ti je 10240 byt·.
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Perzistentní pam¥´ lze resetovat nebo vy£istit pomocí okna pro nahrání - viz Obr. 2.1.
V okn¥ pro nahrání je t°eba p°epnout moºnost na Expert mode a poté vybrat mezi vol-
bami Reset persistent memory nebo Cleanup persistent memory. Pokud vyberete
volbu Reset persistent memory, bude celá perzistentní pam¥´ nahrazena, ale pokud
vyberete volbu Cleanup persistent memory, budou smazány pouze parametry, které
jiº nejsou pouºívány.

Soubor pro trvalé uloºení, jeho velikost, umíst¥ní a £as uloºení lze zm¥nit pomocí
kon�gura£ního souboru rexcore.cfg. Dal²í podrobnosti naleznete v uºivatelské p°íru£ce
RexCore[3].

Bu¤te si v¥domi, ºe parametry bloku budou p°epsány t¥mi uloºenými v perzistentní pa-
m¥ti okamºit¥ po vým¥n¥ exekutivy, pokud je pro funk£ní blok povolena volba Persistent

parameters.
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Kapitola 6

Zálohování a obnova kon�gurace

6.1 Zálohování

Target→Backup (Target → PC)
Backup umoº¬uje vytvo°it zálohu °ídícího algoritmu, který je uloºen na cílovém za°í-

zení. Uºivatel speci�kuje název souboru, do kterého bude záloha uloºena. V této záloze
jsou uloºeny tyto komponenty °ídícího algoritmu: exekutiva, HMI a zdrojové soubory
projektu (pokud jsou zdrojové soubory projektu uloºeny na cílovém za°ízení). Vedle zá-
lohy je vytvo°en textový soubor s podrobnými informacemi o obsahu zálohy.

6.2 Obnova

Target→Restore (PC → Target)
Restore umoº¬uje obnovit °ídící algoritmus zálohovaný v souboru na cílové za°ízení.

Tato operace je velmi podobná operaci pro nahrání algoritmu, ale uºivatel m·ºe speci�-
kovat název zálohy.

6.3 Zdroje na cílovém za°ízení

Pro uloºení zdrojových soubor· na cílovém za°ízení vloºte blok PROJECT do hlavního
souboru projektu a nastavte jeho parametr SourcesOnTarget na True.
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Kapitola 7

Podporované opera£ní systémy

Vývojové nástroje REXYGEN podporují následující opera£ní systémy:

• 64-bit Windows 10 a nov¥j²í

• Linux amd64, armhf, arm64 (zaloºené na Debianu)
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Kapitola 8

Klávesové zkratky

Klávesová zkratka Funkce (jak je prezentována v nabídce)
CTRL+N Nový soubor
CTRL+O Otev°ít soubor
CTRL+S Uloºit soubor
CTRL+P Tisk
CTRL+Z Vrátit zp¥t
CTRL+Y Znovu
CTRL+A Vybrat v²e
CTRL+X Vyjmout
CTRL+C Kopírovat
CTRL+V Vloºit
CTRL+R Oto£it blok o 90 stup¬· v hodinovém sm¥ru
CTRL+SHIFT+R Oto£it blok o 90 stup¬· proti hodinovému sm¥ru
CTRL+F Najít blok funkce
CTRL+E Vlastnosti
CTRL+M Deklarace parametr· subsystému
CTRL+U Otev°ít subsystém
CTRL+G Vytvo°it subsystém
CTRL+L Knihovna blok·
CTRL+W Sledovat výb¥r
CTRL+SHIFT+W Vylou£it ze sledování
F1 Nápov¥da
F2 Zv¥t²it
F3 Zmen²it
F4 Výchozí velikost
F5 Kompilovat
F6 Kompilovat a nahrát
F7 P°ipojit
F8 Odpojit
F9 Aktivovat/deaktivovat reºim sledování
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Tabulka 8.1: Klávesové zkratky v programu REXYGEN Studio
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Kapitola 9

Dal²í d·leºité funkce a nástroje

9.1 Human-Machine Interface

Kaºdé cílové za°ízení s b¥ºícím RexCore obsahuje integrovaný webový server. Webový
server a stránky, které poskytuje, mohou slouºit jako rozhraní mezi £lov¥kem a strojem
(HMI) pro va²i aplikaci. Webové rozhraní s HMI lze otev°ít z REXYGEN Studio volbou
Target/Web Interface v nabídce.

Podívejte se na dokumentaci bloku HMI v [2] pro za£len¥ní HMI do va²eho projektu.
V²echny typy HMI podporované REXYGEN jsou popsány v [4].

9.2 REXYGEN HMI Designer

Jedním z p°ístup· k vytvo°ení HMI pro va²i aplikaci je pouºití REXYGEN HMI Designer.
REXYGEN HMI Designer lze spustit p°ímo z REXYGEN Studio kliknutím na Tools/REXYGEN

HMI Designer v nabídce nebo kliknutím na ikonu na panelu nástroj·. Podrobnosti o po-
uºití REXYGEN HMI Designer najdete v [5] a [4].
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